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What's In My Lunch? 
Quantitative Food Allergy ELISA
Experiment Objective:

In this inquiry-based experiment, students will master the concepts and methodology 
behind the enzyme-linked immunosorbent assay (ELISA). Students will perform an ELISA 
to detect the presence of whey protein in various food products. A standard curve will be 
created to quantify the concentration of whey in each sample.

See page 3 for storage instructions.
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Experiment Components

COMPONENTS 	 Storage	 Check (√)

A	 10x ELISA Wash Buffer	 Refrigerator	 q
B	 ELISA Dilution Buffer	 Refrigerator	 q
C	 Whey Antigen (Lyophilized)	 Refrigerator	 q
D  	 Anti-Whey Antibody (Lyophilized)	 Refrigerator	 q
E	 Secondary Antibody (Lyophilized)	 Refrigerator	 q
F	 TMB Substrate	 Refrigerator	 q
G	 Stop Solution 	 Refrigerator	 q

REAGENTS & SUPPLIES		  Check (√ )
Store all components below at room temperature.

•	 Strip tubes (8-well)		  q
•	 Snap-top microcentrifuge tubes 		  q
•	 Homogenization pestles with tubes		  q
•	 15 mL conical tubes		  q
•	 Transfer pipets		  q

Experiment #266 is 
designed for 10 lab 
groups. 

•	 Various food samples to be tested

•	 Distilled or deionized water

•	 Beakers or flasks

•	 Paper towels

•	 Disposable lab gloves

•	 Safety goggles

•	 Automatic micropipettes (5-50 µL, 100-1000 µL) and tips 

•	 Digital camera or cell phone with camera 

•	 Computers with Internet, image analysis program, and graphing program 

All experiment components 
are intended for educational 
research only.  They are not 
to be used for diagnostic or 
drug purposes, nor admin-
istered to or consumed by 
humans or animals.

Requirements  (not included with this kit)

NOTE:
Disposable transfer pipets 
can be substituted for 
automatic micropipettes if 
necessary. See Cat. #632.
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UNDERSTANDING ALLERGIES

Allergies are one of the most common diseases of the immune system, 
occurring in up to 20% of people in developed countries. An allergic 
response occurs when the immune system overreacts to a foreign 
material, known as an antigen (short for antibody generator). Common 
antigens for allergy sufferers include infectious agents, such as bacteria 
or viruses, chemicals and various environmental materials such as pol-
len and food. Once an antigen enters the body it triggers white blood 
cells to produce antibodies, leading to a swift immune response.
Antibodies are specialized proteins that are used by the body to identify 
and eliminate pathogens. Each antibody is composed of four polypep-
tide chains, two heavy chains and two light chains. These chains are 
linked together by disulfide bonds to create a distinct “Y” shape (Figure 
1). At each tip of the Y is a highly variable region composed of 110-130 
amino acids that gives the antibody its specificity for binding to anti-
gens. Each antibody molecule can bind to two antigen molecules, one 
at each tip. This binding neutralizes the antigen and forms an insoluble 
complex through a process known as immunoprecipitation. 

All allergies begin with sensitization, which starts when a normally 
non-hazardous antigen enters the body and encounters a lymphocyte cell (Figure 2A). For reasons still being researched, the 
lymphocyte cell registers this non-harmful particle as threatening, which triggers the production of novel immunoglobulin E 
(IgE) antibodies (Figure 2B). The highly specific IgE antibodies then attach themselves to immune cells, like mast cells and baso-
phils, which circulate throughout the body (Figure 2C). The sensitization process can take between 6-10 days. After sensitization, 
IgE antibodies in the bloodstream can rapidly bind to their antigen, triggering immune cells to release mediator compounds 
such as histamine and proteoglycans into the body (Figure 2D). Once a person has become sensitized, small amounts of the 
antigen can trigger a full allergic reaction.  Symptoms of an allergic reaction are varied, ranging from sneezing and itchy eyes to 
anaphylaxis (Table 1). 

Anaphylaxis is a severe, whole-body reaction to an allergen. French scientists Charles Richet and Paul Portier coined the term 
in 1902 while studying the toxin produced by the tentacles of the Portuguese Man of War. They isolated the toxin to inject into 
dogs hoping to obtain protection, or “prophylaxis”, against it. However, they were horrified to find that even small doses of the 
toxin resulted in the rapid onset of breathing difficulty in vaccinated dogs. Richet and Portier rightly concluded that the initial 
exposure caused the dog’s immune system to become hyper-sensitized to the toxin. After the first exposure, re-exposure to the 
same compound resulted in a severe reaction, regardless of the dosage. They termed this state “anaphylaxis”, which means 
“against protection”. 

Background Information

Figure 1:  Structure of an antibody.
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Figure 2:  The process of allergy sensitization.
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The leading cause of anaphylaxis in humans is related to the food we eat. Food allergies are a serious and growing health issue 
that affects around 15 million people in the United States alone. For example, Cow’s Milk Protein Allergy (CMPA) is the most 
common food allergy in children. CMPA results when the immune system mistakenly attacks one or more milk proteins present 
in food products. The immune response can be immediate (within minutes), delayed (within hours to days), or both. Common 
symptoms include vomiting, wheezing, and eczema (a detailed list is provided in Table 1).

Between 2 to 3% of the general population are diagnosed with CMPA, although many (79%) outgrow it by the age of 16. For 
sufferers, the main treatment for this condi-
tion is to eliminate cow’s milk protein from 
their diet. Most milk is around 3% protein, 
which can be classified into two categories 
based on the presence or absence of the ele-
ment phosphorus. Caseins contain phosphorus 
and will coagulate or precipitate at a pH of 
4.6. This coagulation at reduced pH is the 
basis for cheese curd formation. Most mam-
mal species contain 3 or 4 different casein 
proteins, which make up approximately 82% 
of the total protein in milk. All other proteins 
found in milk lack phosphorus and are grouped together as whey or serum proteins. The major whey proteins in cow milk are 
beta-lactoglobulin and alpha-lactalbumin. Together, the whey proteins comprise the remaining 18% of protein in milk.

DETECTING FOOD ALLERGENS

In 2005 the FDA began requiring manufacturers to label the presence/absence of eight of the most common allergens (milk, 
eggs, fish, shellfish, peanuts, wheat, soybeans, and tree nuts) in their food products. This labeling helps consumers more easily 
identify and avoid potentially dangerous allergens. To detect these allergens in their product, food companies can use PCR, 
mass spectrometry, or immunochemical assays, although immunochemical assays tend to be the most popular due of their 
approachability and robustness. Immunochemical assays identify a particular substance by its ability to bind to an antibody. One 
commonly used immunochemical assay is the Enzyme Linked Immunosorbent Assay (ELISA).

ELISAs can determine the presence and concentration of specific antigens in complex solutions. To accomplish this, ELISAs rely 
on the ability of an antibody to recognize and bind to specific antigens. Most ELISAs use two different antibodies – a primary an-
tibody that is specific to the antigen of interest and a secondary antibody that recognizes the antigen-antibody complex (Figure 
3A). This secondary antibody is coupled to an enzyme that reacts with a substrate to produce a signal. ELISAs can be designed 
to detect antigens for a large variety of purposes. For example, in medicine ELISAs are often used to determine serum antibody 
concentrations. This information helps doctors to diagnose viral, bacterial, and parasitic infections.  ELISAs can also be used to 
identify genetically modified organisms, trace drug use, and confirm pregnancy.

Traditional ELISAs are performed in transparent microtiter plates made of polystyrene or polyvinyl chloride. The sample to be 
tested is deposited into small wells and proteins present in the solution, including the antigen under investigation, will stick to 
the plate. These proteins/antigens are allowed to bind to the plate during a short incubation period (Figure 3B). After this the 
wells are washed to remove unabsorbed antigens and a solution that contains the primary antibody is added to the wells. If 
the antigen is present in the wells then it will bind to the antibody and form a complex.

Following a second wash, a solution containing the enzyme-linked secondary antibody is added to the wells (Figure 3B). This 
secondary antibody will bind to the antigen and primary antibody complex.  After a final washing step, a colorless substrate 
solution containing 2,2'-azino-bis (3-ethylbenzothiazoline-6-sulphonic acid) (also known as ABTS) is added. If there is any 
secondary antibody bound to the well then the linked enzyme Horseradish Peroxidase (HRP) will will catalyze a reaction that 
produces a colored product from the ABTS (Figure 3B). 

Since each secondary antibody can produce many molecules of the converted substrate ELISAs are very sensitive, even at 
extremely low levels of antigen. ELISAs can be qualitative, in which case they indicate whether or not an antigen is present, 
or quantitative, in which case they also measure the antigen concentration. A quantitative ELISA requires that several wells 
be set-aside as standards. Each standard will contain a solution where the concentration of the antigen of interest is already 

Immediate Reactions 

Delayed Reactions 

Table 1: Potential Symptoms of an Allergic Reaction

Anaphylaxis, acute rash, wheezing, sneezing, 
congestion, dry cough, vomiting, acute asthma, 
swelling of the larynx

Atopic dermatitis, vomiting and diarrhea, constipation, 
poor growth, inflammation in digestive tract.
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known. The signal intensity in each well is measured and the values of the standards are plotted to create a standard curve. The 
intensity of the unknown samples can then be compared to the standard curve to determine an approximate protein concentra-
tion. Quantitative ELISAs are used in research, medicine, and industry tests. 

In this exploration, students will perform an ELISA to examine the presence of whey protein in various food products. Students 
will also prepare a standard curve containing known amounts of whey protein. This standard curve will be used to estimate the 
concentration of whey in their food samples. As a STEM activity, students will create a standard curve base on image density 
measurements. This exercise will allow students to calculate the amount of whey found in a food sample.  

Figure 3:  Overview of the ELISA.
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EXPERIMENT OBJECTIVE:  

In this inquiry-based experiment, students will master the concepts and methodology behind the enzyme-linked immunosor-
bent assay (ELISA). Students will perform an ELISA to detect the presence of whey protein in various food products. A standard 
curve will be created to quantify the concentration of whey in each sample.

Experiment Overview

Wear gloves 
and safety goggles

Preparation of 
Food Samples 

Allergen Detection by
ELISA

Qualitative Analysis of
Allergen Testing

Quantitative Analysis of
Allergen Testing

LABORATORY SAFETY

1.	 Gloves and goggles should be worn routinely as good laboratory practice.

2.	 Always wash hands thoroughly with soap and water after handling contaminated materials. 

LABORATORY NOTEBOOKS:

Scientists document everything that happens during an experiment, including experi-
mental conditions, thoughts and observations while conducting the experiment, and, of 
course, any data collected. Today, you’ll be documenting your experiment in a labora-
tory notebook or on a separate worksheet.

Before starting the Experiment:

•	 Carefully read the introduction and the protocol. Use this information to form a 
hypothesis for this experiment. 

•	 Predict the results of your experiment.  

During the Experiment: 

• 	 Record your observations.

After the Experiment:

•	 Interpret the results – does your data support or contradict your hypothesis? 
•	 If you repeated this experiment, what would you change? Revise your hypothesis 

to reflect this change.

What's In My Lunch? Quantitative Food Allergy ELISAEDVO-Kit 266
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Module I: Preparation of Food Samples

1.	 LABEL a 15 mL tube with the name of your food sample and the letter "A". Also LABEL three microcentrifuge tubes B, C, 
and D for the food sample dilutions.

2.	 ADD 450 µL of Food Dilution Buffer to each microcentrifuge tube.
3.	 For LIQUID samples (like milk):
	 a.	 ADD 5 µL of liquid food sample and 10 mL Food Dilution Buffer to the labeled 15 mL tube to create a 1x103 dilution. 

Mix well.  PROCEED directly to step 5.
4.	 For SOLID food samples (like cheese):
	 a.	 COMBINE 0.1 g of the food with 500 µL of Food Dilution Buffer in a microcentrifuge tube. 
	 b.	 Use a pestle to completely MASH food.
	 c.	 ADD 5 µL of the mashed food sample solution and 10 mL Food Dilution Buffer to the labeled 15 mL tube to create a 

1x103 dilution. Mix well.
5.	 Prepare a serial dilution of your food sample. ADD 50 µL of the 103 food sample (tube A) to tube B, MIX well. ADD 50 µL of 

the 104 food sample (tube B) to tube C, MIX well. ADD 50 μL of the 105 food sample (tube C) to tube D, MIX well.
6. 	 PROCEED to Module II.

5 µL

5 µL

 Well A B C D

 Concentration 1:103 1:104 1:105 1:106

 Dilution Food sample dilution 50 µL of 1:103 (A)  50 µL of 1:104 (B)  50 µL of 1:105 (C)
  prepared in sample + 450 µL sample + 450 µL  sample + 450 µL  
  step 3 or 4 food dilution buffer food dilution buffer food dilution buffer

In this module you will prepare and dilute your food sample. Creating a serial dilution ensures that at least one tested food 
concentration falls inside the concentration range described by the standard curve.

OPTIONAL STOPPING POINT:
The experiment can be stopped after step 5 by placing the diluted food samples (tubes A-D) into overnight 
storage at 4° C. The experiment can be resumed the following day by continuing with Module II.

What's In My Lunch? Quantitative Food Allergy ELISA EDVO-Kit 266
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Module II: Allergen Detection by ELISA

 Preparation of the Standard Curve and Loading Diluted Food Samples:

1.	 Using a fine-tipped marker, LABEL the wells of your 8-well strip 1-8 and the wells of your 4-well strip A-D. 

2.	 ADD 100 µL Standard Curve Buffer to wells 2-8.

3.	 ADD 150 µL of the whey antigen solution to well #1. The antigen is provided at a concentration of 10 μg/ml.

4.	 PIPET 50 µL from well #1 into well #2 and MIX the sample by gently pipetting up and down 5 times.

5.	 Using the same pipette tip, TRANSFER 50 µL from well #2 into well #3 and MIX. Continue to serially DILUTE the remaining 

samples through well #8 according to table 3 below. 

6.	 REMOVE and DISCARD 50 µL of the diluted antigen from well #8.

7.	 ADD 100 µL of the diluted food samples (A, B, C, D) to wells A, B, C, and D. Add the solutions starting with the most dilute 

sample (well D) and ending with the most concentrated sample (well A) or change tips between each sample. 

8.	 INCUBATE the strips for 5 minutes at room temperature. While you are incubating, CALCULATE the antigen concentrations 

for wells 1 through 8 and RECORD your answers in Table 3. 

 Well 1 2 3 4 5 6 7 8
 Dilution --- 1:3 1:9 1:27 1:81 1:243 1:729 1:2187
 Dilution 150 µL of 50 µL of 50 µL of 50 µL of 50 µL of 50 µL of 50 µL of 50 µL of 
 Procedure whey well 1 into well 2 into well 3 into well 4 into well 5 into well 6 into well 7 into
  antigen 100 µL 100 µL 100 µL 100 µL 100 µL 100 µL 100 µL  
   standard standard standard standard standard standard standard
   curve buffer curve buffer curve buffer curve buffer curve buffer curve buffer curve buffer
 Concentration 10 µg/mL

 1    2    3    4     5    6    7    8      A    B    C    D

LABEL your 8-well & 4-well strips. ADD 150 µL Whey Antigen.

REMOVE 50 µL from well #8. 

50 µL

TRANSFER 50 µL from well #2 to #3.  

MIX and continue through well #8.

ADD 100 µL diluted food samples. INCUBATE 5 min. at room temperature.

PIPET 50 µL from #1 to #2. MIX.

 1    2    3    4     5    6    7    8      A    B    C    D

 1    2    3    4     5    6    7    8      A    B    C    D

ADD 100 µL Standard Curve Buffer to wells 2-8.

 1    2    3    4     5    6    7    8      A    B    C    D  1    2    3    4     5    6    7    8      A    B    C    D

 1    2    3    4     5    6    7    8      A    B    C    D  1    2    3    4     5    6    7    8      A    B    C    D

 1    2    3    4     5    6    7    8      A    B    C    D

In this module you will perform a 1:3 (3-fold) serial dilution of whey protein to buffer, in order to create a standard curve of 
eight known antigen concentrations. You will then conduct an ELISA on both the diluted food samples and the standard curve 
samples.

What's In My Lunch? Quantitative Food Allergy ELISAEDVO-Kit 266
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Removal of Sample and Washing the Wells:

9.	 INVERT the strips over the sink or a stack of paper towels to remove the samples. Gently TAP the strips 4-5 times onto a 

fresh paper towel.  DISCARD the wet paper towels.

10.	 Using a transfer pipet, ADD Wash Buffer to each well until they are almost full (~200 µL). DO NOT allow the buffer to spill 

over into adjacent wells. 

11.	 INVERT the strips over the sink or a stack of paper towels to remove the samples. Gently TAP the strips 4-5 times onto a 

fresh paper towel. DISCARD the wet paper towels.  

12.	 REPEAT steps 10-11 to wash the wells once more. 

		  OPTIONAL STOPPING POINT: 
		  The experiment can be stopped after step 12 but requires that Wash Buffer be left in all the wells for overnight 	
		  storage at 4° C. The experiment can be resumed up to 24 hours later. Remove the Wash Buffer and continue
 		  with step 13.

Module II: Allergen Detection by ELISA, continued

INVERT onto paper towels. ADD wash buffer to each well.

INVERT onto paper towels. REPEAT steps 10 & 11.

 1    2    3    4     5    6    7    8      A    B    C    D
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Addition and Removal of Antibodies

13.	 Using a new micropipette tip, ADD 50 µL of the primary antibody solution to each well.

14.	 INCUBATE at room temperature for 5 minutes.

15.	 INVERT onto paper towels and TAP.  WASH the wells twice as in steps 10-12. 

16.	 Using a new micropipette tip, ADD 50 µL of the secondary antibody solution to each well.

17.	 INCUBATE at room temperature for 5 minutes.

18.	 INVERT onto paper towels and TAP. WASH the wells twice as in steps 10-12. 

Addition of Substrate

19.	 Using a new micropipette tip, ADD 50 µL of the TMB substrate to all 12 wells. When the first well is a dark blue (2-5 min), 

proceed to Step 20.

	 NOTE: The enzymatic reaction can quickly saturate in wells with a high antigen concentration. Work quickly but 

steadily when adding the TMB substrate.  

20.	 Using a new micropipette tip, ADD 50 μL of Stop Solution to each well. Gently TAP tubes to MIX. 

21.	 DOCUMENT results by using a digital camera to take a picture. Placing the microtiter strips on a white sheet of paper or a 

white light box can enhance the contrast between wells. Photograph both strips simultaneously. The best images are taken 

with the two strips parallel and with the camera directly overhead and 1-2 ft above. When possible, select high resolution. 

22.	 PROCEED to Module III-A.

Module II: Allergen Detection by ELISA, continued

INCUBATE at room temp. INVERT and 

WASH twice. 

INVERT and 

WASH twice. 

ADD 50 µL primary antibody.

 1    2    3    4     5    6    7    8      A    B    C    D

INCUBATE at room temp. 

ADD 50 µL secondary antibody.

ADD 50 µL substrate.

DOCUMENT results. PROCEED to Module III-A.

 1    2    3    4     5    6    7    8      A    B    C    D 1    2    3    4     5    6    7    8      A    B    C    D

 1    2    3    4     5    6    7    8      A    B    C    D

ADD 50 µL Stop Solution.

 1    2    3    4     5    6    7    8      A    B    C    D 1    2    3    4     5    6    7    8      A    B    C    D
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Module III-A: Qualitative Analysis of Allergen Testing

The color intensity of each well reflects the initial concentration of whey. Color intensity can be estimated by eye and described 
or ranked on a scale of 0 (clear) to 10 (blue).  Because the ELISA solution can quickly evaporate it is important to answer ques-
tions 1 - 3 the same day as Module II. Alternatively you can use the picture taken in Module II to answer these questions at a 
later time.

1.	 Which standard curve samples are the darkest?  Which are the lightest?  What does this mean?  How does color intensity 
relate to the concentrations you calculated in Table 3?

2.	 Observe the food sample dilutions. Did any of them change color? 

3.	 Do any of the food sample dilutions wells (A through D) closely resemble the standard curve wells (1 through 8)? 

4.	 Based on this similarity can you estimate the original concentration of whey in the food sample you tested? Remember 
that wells A to D represent food that has been diluted.

What's In My Lunch? Quantitative Food Allergy ELISA EDVO-Kit 266
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Module III-B: Quantitative Analysis of Allergen Testing

The color intensity of each well can be determined using densitometry, the quantitative measurement of light absorption. In this 

ELISA the initial concentration of whey determines how many molecules of TMB are oxidized. Oxidized TMB turns the solution 

blue, which leads to more light absorption. Therefore, by measuring the sample color intensity in the eight wells of known con-

centration, you can establish a relationship between whey concentration and light absorption.  This relationship is described by 

the equation of the standard curve. You can then use the standard curve equation to estimate the original concentration of whey 

in your chosen food.  

1.	 Calculate the mean gray value and the whey protein concentration for the eight standard curve wells.  

	 a.	 Save the digital image of your results as a JPEG on the computer. 

	 b.	 Open the ImageJ program on your computer.

	 c.	 Go to File > Open and open your image. 

	 d.	 Go to Image > Type > 32 bit. 

	 e.	 Go to Edit > Invert. 

	 f.	 Go to Analyze > Set Measurements and select “mean gray value”. 

	 NOTE: In digital images each pixel has a luminance – or light intensity – value which ranges from black (zero intensity) 

to white (full intensity). In Image J this value is called gray value. The mean gray value is calculated by adding all the 

gray values in a selection and then dividing by the total number of pixels. 

	 g.	 Choose the round selection tool and 

draw a circle that fits within the 

first well. NOTE: This circle will be 

used to measure all wells. Be-

cause some cameras can distort 

the shape of the edge wells, we 

suggest making this circle slightly 

smaller than the actual well.

	 h.	 Go to Analyze > Measure. A new 

window titled results should ap-

pear. Record the results for “mean 

gray value” in your lab notebook or 

in the table below.

	 i.	 Click back to the digital image of 

your results and use the mouse 

or arrow keys to move the circle 

to next well. Repeat step h for all 

remaining wells.  

	 j.	 Complete Table 4 (at right) using 

the mean gray values and the anti-

gen concentrations from Table 3

		  (page 9). 

 Well Dilution Mean Gray Whey Protein
   Value Concentration ( µg/mL)
 1 1:1  10
 2 1:3
 3 1:9
 4 1:27
 5 1:81
 6 1:243
 7 1:729
 8 1:2187
 A 1:103 
 B 1:104 
 C 1:105 
 D 1:106 

NOTE:
Detailed download instructions 

for ImageJ can be found at:
http://rsb.info.nih.gov/ij/download.html

What's In My Lunch? Quantitative Food Allergy ELISAEDVO-Kit 266
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Module III-B: Quantitative Analysis of Allergen Testing, continued

2.	 Create a standard curve.

	 a.	 Plot the whey protein con-

centration (x axis) against the 

mean gray value (y axis) for 

each standard concentration. 

	 b.	 Draw a best-fit curve through 

the points in the graph (for best 

results we suggest using graph-

ing software). 

	 c.	 Record the equation of your 

curve for use later.

NOTE:  We suggest a logarithmic

best-fit line. The best-fit line may not 

pass through every data point.

3.	 Determine the concentration of tar-

get protein in a food sample well. 

	 a.	 Find the mean gray values of 

the sample in wells A to D as in 

step 1. 

	 b.	 Select a sample with an inten-

sity value that falls between the maximum and minimum standard curve values. 

	 c.	 Use the equation of the best-fit line to solve for x given the y value. Alternatively, extend a horizontal line from the 

absorbance value of the sample (y-axis) to the standard curve and read the corresponding concentration (x-axis). See 

Figure 5. 

4. 	 Determine the concentration of whey 

in the original food sample. 

	 a. 	 Convert the dilution ratio of the 

well to a decimal number by 

dividing the number on left by 

the number on the right. For 

exsample,  the 1:104 dilution can 

be rewritten as 0.0001.

	 b. 	 Divide the well whey protein 

concentration (calculated in step 

3c) by this number.

Figure 4:  Plotting a Standard Curve.
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Figure 5:  Determining a Protein Concentration.
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Study Questions

1. 	 Describe the structure of an IgE antibody protein. What type of cell produces these proteins?

2. 	 Name and describe two types of milk proteins.

3. 	 Describe an ELISA reaction beginning with the addition of an antigen and ending with the substrate color change.

What's In My Lunch? Quantitative Food Allergy ELISAEDVO-Kit 266
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Instructor's Guide

OVERVIEW OF INSTRUCTORS PRELAB PREPARATION:

This section outlines the recommended pre-lab preparations and approximate time requirement to complete each pre-lab activ-
ity. In addition to preparing and aliquoting the provided components for Module II (table below) you will also need to acquire 
food samples before Module I and make sure your students have access to digital cameras before Module II and access to com-
puters with image processing and graphing programs before Module III.

10X ELISA Wash 
Buffer (A)

Dilute to 1X solution and 
aliquot

Anytime before the experiment. 
Cover and store in the refrigerator.

Strip Tubes Divide five strips Anytime before the experiment. 

Component: What to do: When:

ELISA Dilution 
Buffer (B)

Use to rehydrate components 
C, D, and E and to prepare 
food and curve buffers. 

Anytime before the experiment.
Store tubes in the refrigerator.

Whey Antigen (C) Rehydrate and aliquot Up to one week before performing 
the experiment.

Anti-Whey Antigen 
(D)

Rehydrate and aliquot Up to one week before performing 
the experiment.

Secondary Antibody 
(E)

Rehydrate and aliquot On the same day as performing the 
experiment.

TMB Substrate (F) Aliquot Up to one week before performing 
the experiment.

Stop Solution (G) Aliquot Up to one week before performing 
the experiment.

Red = Prepare immediately before module.           Yellow = Prepare shortly before module.           Green = Flexible / prepare up to a week before the module.
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Pre-Lab Preparations 

Acquire Food Samples

A variety of dairy and dairy-free products can be tested. Encour-
age student groups to bring in their own samples! While results 
will vary depending on the brand used Table 5 provides a list of 
suggested products and their general results.

Prepare Strip Tubes

Fifteen strip tubes are provided in this kit. For the experiment, 
each student group will need one full strip (8 wells) for the 
standard curve and one half strip (4 wells) for the food sample. 
To create the 4-well strip, divide 5 full strips in half. 

Obtain Digital Camera

For the purposes of this experiment almost all digital cameras, 
including those found on cell phones, can be used. Digital 
cameras will include a USB cable and/or memory cards for trans-
ferring the pictures to the computers. If you are using a cell phone, the images can be sent to an email address.  Many image 
formats can be used including TIFF, GIF, and JPEG. 

Computer Requirements For Module III-B

In order to perform the quantitative analysis, students will need a computer with image analysis software and a graphing 
program capable of finding a best-fit curve.  A number of programs can be used to compare the intensity of the twelve wells. 
We recommend ImageJ (version 1.49 or newer). ImageJ is an image processing program developed at the National Institute of 
Health. It is in the public domain and so can be freely downloaded and installed. Detailed download instructions and the appro-
priate ImageJ file for your platform can be found at http://rsb.info.nih.gov/ij/download.html. In order to run ImageJ, you will 
need to have Java running on the computer.  Please consult the appropriate technology support personnel for your institution 
for assistance. Numerous graphing programs are available. Alternatively, results can be plotted on semi-logarithmic paper and a 
linear trend line added by hand. 

Removing the Samples and Washing the Wells 

As an alternative to inverting the strips to remove the samples during Module II, students can use a pipette to remove the 
samples and wash buffers. In this case, it is important to change pipettes or pipette tips between wells to prevent cross-con-
tamination. Additional micro transfer pipets can be ordered from Edvotek (Cat. 632).  To reduce waste, transfer pipets can be 
labeled and reused for the same well in future steps.

Product Tested

Table 5:  Expected Results from Dairy Products

ELISA Color Change

Cow's Milk Dark
Soy Milk None
Protein Drink Light 
Dairy Coffee Creamer Light
Fresh Cream Light to Dark (depending on brand) 
Dairy Cheese Light
Dairy Yogurt  Light to Dark
Dairy Ice Cream Light to Dark
Dairy Free Yogurt  None
Dairy Free Ice Cream Light
Cookies/Cakes None to Light
Salad Dressing Light
Butter None
Candy bar (nougat) Light
Energy/Protein bar Dark
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Pre-Lab Preparations

Preparation of Wash Buffer

1.	 ADD all of the 10x ELISA Wash Buffer (A) to 180 mL of distilled water. MIX 
well.

2.	 DISPENSE 18 mL into small beakers for each of the 10 lab groups. LABEL the 
beakers as “Wash Buffer”.

Preparation of Sample Preparation Buffers  

1. 	 In a 250 mL beaker/flask, DILUTE 7 mL of the ELISA Dilution Buffer (B) in 
	 150 mL of distilled water. 
2. 	 DISPENSE 13 mL of the dilution from step 1 into ten small beakers. LABEL as 

"Food Dilution Buffer".
3.	 DISPENSE 1 mL of the dilution from step 1 into ten microcentrifuge tubes and 

LABEL as "Standard Curve Buffer".
4. 	 SAVE the remaining ELISA Dilution Buffer (B) for subsequent steps. 

Preparation of Whey Antigen for Standard Curve

1. 	 TRANSFER 7 mL of ELISA Dilution Buffer (B) to a 15 mL conical tube. Label as 
“Antigen”.

2. 	 Carefully REMOVE the stopper from the vial of lyophilized Antigen (C) and 
TRANSFER approximately 0.5 mL of the ELISA Dilution Buffer from the tube in 
step 1. CLOSE the stopper and gently shake the vial to MIX. 

3. 	 TRANSFER 0.25 mL (250 µL) of the rehydrated Antigen back to the conical tube from step 1. MIX well. 
4. 	 LABEL ten microcentrifuge tubes as “Whey Antigen” and DISPENSE 200 μL of the prepared solution into these tubes. 

Preparation of Primary Antibody

1. 	 TRANSFER 7 mL of ELISA Dilution Buffer (B) to a 15 mL conical tube. Label as “Primary Antibody”.
2. 	 Carefully REMOVE the stopper from the vial of lyophilized Primary Antibody (D) and TRANSFER approximately 0.5 mL of 

the ELISA Dilution Buffer from the tube in step 1. CLOSE the stopper and gently shake the vial to MIX. 
3. 	 TRANSFER the entire volume of the rehydrated Primary Antibody back to the conical tube from step 1. MIX well. 
4. 	 LABEL ten microcentrifuge tubes as “Primary Antibody” and DISPENSE 700 μL of the prepared solution into these tubes.

Preparation of Secondary Antibody
Prepare the same day as needed for the experiment.

1. 	 TRANSFER 7 mL of ELISA Dilution Buffer (B) to a 15 mL conical tube. Label as “Secondary Antibody”.
2. 	 Carefully REMOVE the stopper from the vial of lyophilized Secondary Antibody (E) and TRANSFER approximately 0.5 mL of 

the ELISA Dilution Buffer from the tube in step 1. CLOSE the stopper and gently shake the vial to MIX. 
3. 	 TRANSFER the entire volume of the rehydrated Secondary Antibody back to the conical tube from step 1. MIX well. 
4. 	 LABEL ten microcentrifuge tubes as “Secondary Antibody” and DISPENSE 700 μL of the prepared solution into these tubes. 

Preparation of TMB Substrate and Stop Solution

1. 	 Dispense 700 µL of the TMB Substrate (F) into ten microcentrifuge tubes labeled “Substrate”.
2.  	 Dispense 700 µL of Stop Solution (G) into ten microcentrigue tubes. Label the tubes as "Stop".

FOR MODULE I
Each Group should receive:
•	 13 mL Food Dilution Buffer
•	 Food Sample for analysis
•	 15 mL conical tube
•	 3 microcentrifuge tubes
•	 1 tube with pestle (for solid foods)

FOR MODULE II
Each Group should receive:
•	 One 8-well strip and one 4-well strip
•	 18 mL Wash Buffer
•	 1 mL Standard Curve Buffer
•	 200 µL Whey Antigen
•	 700 µL Primary Antibody
•	 700 µL Secondary Antibody
•	 700 µL Substrate
•	 700 µL Stop Solution
•	 Adjustable micropipette and tips
•	 1 large transfer pipet
•	 Empty beaker for waste 
•	 Paper towels

FOR MODULE III
Each Group will need:
•	 Access to computer with image 

processing and graphing programs
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MODULE II

Below are the results for an ELISA we ran using half and half cream. The results in wells A through D will vary depending on 
what food samples are used. The results in wells 1 through 8 can also vary depending on a number of factors, including incuba-
tion times, accuracy of pipetting, and background lighting.

MODULE III-A

1.	 Which standard curve samples are the darkest? Which are the lightest? What does this mean? How does color inten-
sity relate to the concentrations you calculated in Table 3? 

	 Well 1, which contained the standard curve sample of whey at a 10 μg/mL concentration, is the darkest while well 8, 
which contained the standard curve sample of whey at 0.0046 μg/mL, is the lightest. This means that the darker the reac-
tion the higher the concentration of whey. 

2.	 Observe the food sample dilutions. Did any of them change color? 

	 All four wells changed color. Well A showed the most color change while well C And D showed only slight color changes. 

3.	 Do any of the food sample dilutions wells (A through D) closely resemble the standard curve wells (1 through 8)? 

	 Well A looks similar in color intensity to wells 1 and 2, well B looks similar to wells 5 and 6, and wells C and D both look 
similar to wells 7 and 8. 

4.	 Based on this similarity can you estimate the original concentration of whey in the food sample you tested? Re-
member that wells A to D represent food that has been diluted. 

	 Based on the similarity between well A and wells 1, it would seem that the original food concentration had a whey con-
centration of 10 µg/mL * 1000 which equals 10,000 µg / mL.

Experiment Results and Analysis
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Module III-B

Below are the image and table generated in step 1.

Experiment Results and Analysis

 Well Dilution Mean Gray Whey Protein
   Value Conc. (µg/mL)
 1 1:1 177.84 10.0000
 2 1:3 162.645 3.3333
 3 1:9 160.823 1.1111 
 4 1:27 149.56 0.3704
 5 1:81 145.953 0.1235
 6 1:243 144.029 0.0412
 7 1:729 142.504 0.0137
 8 1:2187 135.357 0.0046
 A 1:103 199.33 Unknown
 B 1:104 164.01 Unknown
 C 1:105 134.667 Unknown
 D 1:106 129.667 Unknown
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Module III-B, continued

Below is the scatter plot graph and logarithmic best-fit line created in step 2. 

Experiment Results and Analysis

For step 3 only the food dilution in well B (mean grey value of 164.01) fell within the range of the standard curve. 
This was used to calculate the whey concentration using the best-fit line equation. 

Equation of the line: 	 y = 4.8988 ln(x) + 159.9
			   y represents the mean gray scale value
			   x represents the whey concentration

Solving for x:  		  164.01 = 4.8988 ln(x) + 159.9
			   4.11 = 4.8988 ln(x)
			   0.8389 = ln(x)
			   e(0.8389) = eln(x)

			   2.3138 = x

Finally, in step 4, the original dilution factor (1:104) is converted into a decimal (0.0001). The x value from 
above (2.314) is then divided by this number to calculate the original concentration of whey in the food sample: 
2.3138/0.0001 = 23,138 μg/mL.

Whey Protein Concentration (µg/mL)
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Please refer to the kit 
insert for the Answers to 

Study Questions




